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Product Basics
See these sections to learn about the basic features of your product.
Printer Parts Locations
The Power Off Timer

Printer Parts Locations
See these sections to identify the parts on your printer.
Printer Parts - Top
Printer Parts - Back
Printer Parts - Inside
Printer Parts - Control Panel Buttons and Lights
Parent topic: Product Basics

Printer Parts - Top
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1 Paper support
2 Sheet feeder
3 Printer cover
4 CD/DVD feed tray
5 Output tray
6 USB Type A port for external devices
7 Edge guides

Parent topic: Printer Parts Locations

Printer Parts - Back

1 AC inlet
2 USB port for computer connection

Parent topic: Printer Parts Locations
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Printer Parts - Inside

1 Ink cartridge lights
2 Ink cartridge cover
3 Ink cartridge holder (do not remove)
4 Print head
5 Control panel

Parent topic: Printer Parts Locations
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Printer Parts - Control Panel Buttons and Lights

1 The WiFi light
2 The power light
3 The power button
4 The Wi-Fi button
5 The network status button
6 The paper/cancel button and light
7 The ink button and light

Parent topic: Printer Parts Locations
Related references
Printer Light Status

The Power Off Timer
The product turns off automatically if it is not used for a period of time after it enters sleep mode. You can
adjust the time period before power off, but increasing the time reduces the product's energy efficiency.
Changing the Power Off Timer Setting - Windows
Changing the Power Off Timer Setting - Mac OS X
Parent topic: Product Basics
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Changing the Power Off Timer Setting - Windows
You can use the printer software to change the time period before the product turns off automatically.
1. Right-click the product icon in the Windows taskbar and select Printer Settings.
2. Click the Maintenance tab.
3. Click the Printer and Option Information button.

You see this screen:

4. Select the time period you want as the Power Off Timer setting.
5. Click Send.
6. Click OK to exit.
Parent topic: The Power Off Timer

Changing the Power Off Timer Setting - Mac OS X
You can use the printer software to change the time period before the product turns off automatically.
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1. Do one of the following:
• Mac OS X 10.6/10.7: In the Apple menu or the Dock, select System Preferences. Select Print &

Fax or Print & Scan, select your product, and select Options & Supplies. Select Utility and
select Open Printer Utility.

• Mac OS X 10.4/10.5: In the Apple menu or the Dock, select System Preferences. Select Print &
Fax, select your product, and select Open Print Queue or Print Queue. Select Utility.

2. Select Printer Settings.
You see this screen:

3. Select the time period you want as the Power Off Timer setting.
4. Click Apply.
Parent topic: The Power Off Timer
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Loading Paper
Before you print, load paper for the type of printing you will do.
Loading Paper
Loading Envelopes
Paper Loading Capacity
Available EPSON Papers
Borderless Paper Type Compatibility
Paper or Media Type Settings

Loading Paper
You can print on a variety of paper types and sizes.
1. Open the paper support and pull up the extensions.
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2. Open the output tray and pull out the extensions.

3. Slide the edge guide left.
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4. Insert paper, glossy or printable side up and short edge first, against the right side and behind the
tab. Then, slide the edge guide against the paper, but not too tightly. If you are inserting a stack of
paper, fan the sheets first and tap the stack on a flat surface to even the edges.

Note: During printing the left edge guide automatically moves 0.12 inch (3 mm) to the left. Do not
move it back manually.

Always follow these paper loading guidelines:
• Load only the recommended number of sheets.
• Load paper short edge first, no matter which way your document or photo faces.
• Load letterhead or pre-printed paper top edge first.
• Do not load paper past the arrow mark inside the edge guide.
• Do not load paper with holes punched in it.
• Check the paper package for any additional loading instructions.
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Parent topic: Loading Paper
Related references
Paper Loading Capacity

Loading Envelopes
You can print on plain paper envelopes in this size: No. 10 (4.1 × 9.5 inches [105 × 241 mm]).
1. Open the paper support and pull up the extensions.
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2. Open the output tray and pull out the extensions.

3. Slide the edge guide left.
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4. Load up to 10 envelopes against the right side, printable side up, and flap edge left. Then, slide the
edge guide against the envelopes, but not too tightly.

Always follow these envelope loading guidelines:
• If you have trouble loading a stack of envelopes, press each envelope flat before loading it or load one

envelope at a time.
• Do not load envelopes that are curled, folded, or too thin.
Parent topic: Loading Paper
Related references
Paper Loading Capacity

Paper Loading Capacity
Paper type Load up to this many sheets
Plain paper* Approximately 100 sheets**
Letter (8.5 × 11 inches [216 × 279 mm])
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Paper type Load up to this many sheets
EPSON Bright White Paper 80 sheets
EPSON Presentation Paper Matte A3 or larger sizes: 50 sheets

Smaller sizes: 100 sheets
EPSON Ultra Premium Photo Paper Glossy 20 sheets
EPSON Photo Paper Glossy A3 or larger sizes: 10 sheets
EPSON Premium Photo Paper Glossy Smaller sizes: 20 sheets
EPSON Premium Photo Paper Semi-gloss
EPSON Premium Presentation Paper Matte
EPSON Ultra Premium Presentation Paper Matte
EPSON Ultra Premium Photo Paper Luster
EPSON Premium Presentation Paper Matte 1 sheet
Double-sided
EPSON Brochure & Flyer Paper Matte Double-
sided
EPSON Photo Quality Self-adhesive Sheets
EPSON Iron-on Cool Peel Transfer paper

* Based on 20 lb (75 g/m²) paper weight. Do not load paper above the arrow mark inside the edge guide.
** For two-sided printing, load up to 80 sheets.
Parent topic: Loading Paper

Available EPSON Papers
You can purchase genuine EPSON ink and paper at EPSON Supplies Central at www.epson.com/ink3
(U.S. sales) or www.epson.ca (Canadian sales). You can also purchase supplies from an EPSON
authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).

Paper Type Size Part number Sheet count
EPSON Bright White Paper Letter (8.5 × 11 inches S041586 500

[216 × 279 mm])
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Paper Type Size Part number Sheet count
EPSON Photo Paper Glossy 4 × 6 inches (102 × 152 mm) S041809 50

S042038 100
Letter (8.5 × 11 inches S041141 20
[216 × 279 mm]) S041649 50

S041271 100
11 × 17 inches (279 × 432 S041156 20
mm)
13 × 19 inches (330 × 483 S041143 20
mm)

EPSON Premium Photo Paper 4 × 6 inches (102 × 152 mm) S041808 40
Glossy S041727 100

5 × 7 inches (127 × 178 mm) S041464 20
8 × 10 inches (203 × 254 mm) S041465 20
Letter (8.5 × 11 inches S042183 25
[216 × 279 mm]) S041667 50
11 × 14 inches (279 × 356 S041466 20
mm)
11 × 17 inches (279 × 432 S041290 20
mm)
11.7 × 16.5 inches (297 × 420 S041288 20
mm)
13 × 19 inches (330 × 483 S041289 20
mm)
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Paper Type Size Part number Sheet count
EPSON Ultra Premium Photo 4 × 6 inches (102 × 152 mm) S042181 60
Paper Glossy S042174 100

5 × 7 inches (127 × 178 mm) S041945 20
8 × 10 inches (203 × 254 mm) S041946 20
Letter (8.5 × 11 inches S042182 25
[216 × 279 mm]) S042175 50

EPSON Ultra Premium Photo Letter (8.5 × 11 inches S041405 50
Paper Luster [216 × 279 mm])

11.7 × 16.5 inches (297 × 420 S041406 50
mm)
13 × 19 inches (330 × 483 S041407 50
mm)

EPSON Premium Photo Paper 4 × 6 inches (102 × 152 mm) S041982 40
Semi-gloss Letter (8.5 × 11 inches S041331 20

[216 × 279 mm])
13 × 19 inches (330 × 483 S041327 20
mm)

EPSON Presentation Paper Matte Letter (8.5 × 11 inches S041062 100
[216 × 279 mm])
Legal (8.5 × 14 inches S041067 100
[216 × 357 mm])
11 × 17 inches (279 × 432 S041069 100
mm)
13 × 19 inches (330 × 483 S041070 100
mm)
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Paper Type Size Part number Sheet count
EPSON Premium Presentation 8 × 10 inches (203 × 254 mm) S041467 50
Paper Matte Letter (8.5 × 11 inches S041257 50

[216 × 279 mm]) S042180 100
11 × 14 inches (279 × 356 S041468 50
mm)
11.7 × 16.5 inches (297 × 420 S041260 50
mm)
13 × 19 inches (330 × 483 S041263 50
mm)

EPSON Premium Presentation Letter (8.5 × 11 inches S041568 50
Paper Matte Double-sided [216 × 279 mm])
EPSON Ultra Premium Letter (8.5 × 11 inches S041341 50
Presentation Paper Matte [216 × 279 mm])

11.7 × 16.5 inches (297 × 420 S041339 50
mm)
13 × 19 inches (330 × 483 S041343 50
mm)

EPSON Brochure & Flyer Paper Letter (8.5 × 11 inches S042384 150
Matte Double-sided [216 × 279 mm])
EPSON Photo Quality Self- A4 (8.3 × 11.7 inches S041106 10
adhesive Sheets [210 × 297 mm])
EPSON Iron-on Cool Peel Transfer Letter (8.5 × 11 inches S041153 10
paper [216 × 279 mm])

Parent topic: Loading Paper

Borderless Paper Type Compatibility
You can print borderless photos on compatible paper types in compatible sizes:

Borderless Paper Types
• EPSON Photo Paper Glossy
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• EPSON Premium Photo Paper Glossy
• EPSON Ultra Premium Photo Paper Glossy
• EPSON Premium Photo Paper Semi-gloss
• EPSON Ultra Premium Photo Paper Luster
• EPSON Premium Presentation Paper Matte
• EPSON Ultra Premium Presentation Paper Matte

Borderless Paper Sizes
• 4 × 6 inches (102 × 152 mm)
• 5 × 7 inches (127 × 178 mm)
• 8 × 10 inches (203 × 254 mm)
• 11 × 14 inches (279 × 356 mm)
• 11 × 17 inches (279 × 432 mm)
• 11.7 × 16.5 inches (297 × 420 mm)
• 12 × 12 inches (305 × 305 mm)
• 13 × 19 inches (330 × 483 mm)
Parent topic: Loading Paper

Paper or Media Type Settings
For this paper Select this paper Type or Media Type setting
Plain paper Plain Paper/Bright White Paper
EPSON Bright White Paper
EPSON Iron-on Cool Peel Transfer paper
EPSON Photo Quality Self-adhesive Sheets
EPSON Photo Paper Glossy Photo Paper Glossy
EPSON Premium Photo Paper Glossy Premium Photo Paper Glossy
EPSON Ultra Premium Photo Paper Glossy Ultra Premium Photo Paper Glossy
EPSON Premium Photo Paper Semi-gloss Premium Photo Paper Semi-Gloss
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For this paper Select this paper Type or Media Type setting
EPSON Ultra Premium Photo Paper Luster Ultra Premium Photo Paper Luster
EPSON Presentation Paper Matte Presentation Paper Matte
EPSON Premium Presentation Paper Matte Premium Presentation Paper Matte
EPSON Premium Presentation Paper Matte
Double-sided
EPSON Brochure & Flyer Paper Matte Double-
sided
EPSON Ultra Premium Presentation Paper Matte Ultra Premium Presentation Matte
Envelopes Envelope

Parent topic: Loading Paper
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Printing From a Computer
Before printing documents or photos from your computer, make sure you have set up your product and
installed its software as described on the Start Here sheet.

Note: It is a good idea to check for updates to your product software on Epson's support website.

Printing with Windows
Printing with Mac OS X 10.5, 10.6, or 10.7
Printing with Mac OS X 10.4
Cancelling Printing Using a Product Button

Printing with Windows
You can print with your product using any Windows printing program, as described in these sections.
Selecting Basic Print Settings - Windows
Selecting Advanced Print Settings - Windows
Selecting Print Layout Options - Windows
Selecting a Printing Preset - Windows
Printing Your Document or Photo - Windows
Selecting Default Print Settings - Windows
Changing Automatic Update Options
Parent topic: Printing From a Computer

Selecting Basic Print Settings - Windows
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.
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3. If necessary, select your product name as the printer you want to use.

Note: You may also need to select Properties or Preferences to view your print settings.

You see the Main tab of your printer settings window:

4. If necessary, select Sheet for the Source setting.
5. Select the Quality Option setting that matches your print content and the print quality you want to

use.
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6. Select the type of paper you loaded as the Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

7. Select the size of the paper you loaded as the Size setting.

Note: You can also select the User Defined setting to create a custom paper size.

8. Select one of the border options:
• If you are printing a borderless photo, select Borderless.

Note: You must select a compatible borderless paper type and size to print borderlessly. Check
the borderless paper compatibility list for details.

• If you are printing a document or a photo with borders, select Borders.
9. Select the orientation of your document or photo as shown in the printer settings window.

Note: If you are printing an envelope, select Landscape.

10. Select any of the available print options.

Note: If you need to access the Epson product support website, click the Online Support button.

Basic Print Options - Windows
Parent topic: Printing with Windows
Related references
Borderless Paper Type Compatibility
Paper or Media Type Settings
Related tasks
Printing Your Document or Photo - Windows

Basic Print Options - Windows
You can select any of the basic print options to customize your print. Some options may be pre-selected
or unavailable, depending on other settings you have chosen.
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Fix Photo
Improves the color, contrast, and sharpness of flawed photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to
retain the special color effects.

Fix Red-Eye
Reduces or removes red-eye in photos.

Reverse Order
Prints multi-page print jobs last page first.

Print Preview
Displays a preview of your printout before printing.

Parent topic: Selecting Basic Print Settings - Windows

Selecting Advanced Print Settings - Windows
Select print settings on the Advanced tab to customize the quality and color settings for your printout,
and save your own printing presets.
1. Click the Advanced tab.

You see the advanced print settings:
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2. Select the Paper & Quality Options settings for your printout:
• Make sure Sheet is selected.
• Select the type of paper you loaded.

Note: Check the paper type settings list for details.

• Select the print quality setting you want to use.

Note: Check the print quality setting list for details.

• Select the size of the paper you loaded.
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• Select Borderless to print a borderless photo, or Borders to print a document or a photo with
borders.

Note: You must select a compatible borderless paper type and size to print borderlessly. Check
the borderless paper compatibility list for details.

3. Select Portrait or Landscape as the orientation of your document or photo.

Note: If you are printing an envelope, select Landscape.

4. Select any of the available advanced print options.
5. Select any of the available color management options, or turn off color management.
Advanced Print Quality Settings - Windows
Advanced Print Options - Windows
Color Management Options - Windows
Parent topic: Printing with Windows

Advanced Print Quality Settings - Windows
You can select any of the print quality settings to fine-tune the quality of your print. Some settings may
be unavailable, depending on the paper type and border setting you have chosen.
Economy

For fast printing with reduced quality.
Normal

For everyday text and image printing.
Fine

For text and graphics with good quality and print speed.
Photo

For photos and graphics with good quality and print speed.
Photo RPM

For the best print quality, but the slowest print speed.
Parent topic: Selecting Advanced Print Settings - Windows

Advanced Print Options - Windows
You can select any of the print options to customize your print. Some options may be unavailable,
depending on other settings you have chosen.
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Fix Red-Eye
Reduces or removes red-eye in photos.

High Speed
Speeds up printing, but may reduce print quality.

Edge Smoothing
Smooths jagged edges in low-resolution images such as screen captures or images from the Web.

Print Preview
Displays a preview of your printout before printing.

Black/Grayscale
Prints text and graphics in black or shades of gray.

Parent topic: Selecting Advanced Print Settings - Windows
Color Management Options - Windows

You can adjust the Color Management settings on the Advanced tab to fine-tune the colors in your
printout, or turn off color management in your printer software.
Color Controls

Lets you select a Color Mode setting, individual settings for Brightness, Contrast, Saturation, and
Density, and individual color tones. If you select the Adobe RGB color mode, you can also adjust the
midtone density using the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to
retain the special color effects.

ICM
Lets you turn off color management in your printer software using the Off (No Color Adjustment)
option. You can then manage color using only your application software.

Parent topic: Selecting Advanced Print Settings - Windows

Selecting Print Layout Options - Windows
You can select a variety of sizing and layout options for your document or photo on the Page Layout tab.
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• To change the size of your printed document or photo, select the Reduce/Enlarge Document
checkbox and select sizing options.

• To print on both sides of your paper, select the 2-sided printing options.
• To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select

the Multi-Page checkbox and select the options you want.
• To print multiple copies and arrange their print order, select the Copies options.
• To control printing at the edges of borderless images, select a Borderless option:

• To adjust the automatic settings, select Auto Expand as the Enlargement Method setting, then
adjust the Expansion slider (if necessary) to control the amount of image expansion.
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Note: If you select the Min option for the Expansion setting, you may see white borders on your
printed photo.

• To print the borderless image at its actual size without scaling, select Retain Size as the
Enlargement Method setting.

• To add a watermark to your printout, select Watermark settings.
• To rotate or flip the printed image, select the Rotate 180° or Mirror Image checkboxes.
Parent topic: Printing with Windows

Selecting a Printing Preset - Windows
For quick access to common groups of print settings, you can select a printing preset.

Note: You can create your own preset by clicking the Save Settings button on the Advanced tab.

1. Click the Shortcuts tab.
You see the available Printing Presets options:
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2. Place your cursor over a Printing Presets option to view its list of settings.
3. Use any of the available options on the screen to control your printing presets.
4. To choose an option for printing, select it.
5. Click OK.
Parent topic: Printing with Windows

Printing Your Document or Photo - Windows
Once you have selected your print settings, you are ready to save your settings and print.
1. Click OK to save your settings.

You see your application's Print window, such as this one:
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2. Click OK or Print to start printing.
Checking Print Status - Windows
Parent topic: Printing with Windows

Checking Print Status - Windows
During printing, you see this window showing the progress of your print job. It allows you to control
printing and check ink cartridge status.
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• To cancel printing, click Stop.
• To see print jobs lined up for printing, click Print Queue.
• To check ink status, click Check Ink Levels.
Parent topic: Printing Your Document or Photo - Windows

Selecting Default Print Settings - Windows
When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.
1. Right-click the product icon in the Windows taskbar.
2. Select Printer Settings.

You see the printer settings window:
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3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click OK.
These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.
Changing the Language of the Printer Software Screens
Parent topic: Printing with Windows

Changing the Language of the Printer Software Screens
You can change the language used on the Windows printer software screens.
1. Right-click the product icon in the Windows taskbar.
2. Select Printer Settings.
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You see the printer settings window.
3. Click the Maintenance tab.

You see the maintenance options:

4. Select the language you want to use as the Language setting.
5. Click OK to close the printer software window.
The printer software screens appear in the language you selected the next time you access them.
Parent topic: Selecting Default Print Settings - Windows
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Changing Automatic Update Options
Your printer software for Windows automatically checks for updates to the product driver and firmware.
You can change how often the software checks for updates or disable this feature.
1. Right-click the product icon in the Windows taskbar.
2. Select Auto Update Settings.

You see this window:

3. Do one of the following for each type of update:
• To change how often the software checks for updates, select a setting in the Check every menu.
• To disable the automatic update feature, select the Never option.

4. Click Apply.
5. Click OK to exit.

Note: If you choose to disable the automatic update feature, it's a good idea to periodically check for
updates on Epson's support website.

42



Parent topic: Printing with Windows
Related tasks
Checking for Software Updates

Printing with Mac OS X 10.5, 10.6, or 10.7
You can print with your product using any Mac OS X printing program, as described in these sections.
Selecting Basic Print Settings - Mac OS X 10.5/10.6/10.7
Selecting Page Setup Settings - Mac OS X 10.5/10.6/10.7
Selecting Print Layout Options - Mac OS X 10.5/10.6/10.7
Managing Color - Mac OS X 10.5/10.6/10.7
Selecting Printing Preferences - Mac OS X 10.5/10.6/10.7
Printing Your Document or Photo - Mac OS X 10.5/10.6/10.7
Parent topic: Printing From a Computer

Selecting Basic Print Settings - Mac OS X 10.5/10.6/10.7
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. Select your product as the Printer setting.

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the
print window.
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You see the expanded printer settings window for your product:

Note: The print window may look different, depending on the version of Mac OS X and the
application you are using.

5. Select the Copies and Pages settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before
printing.

6. Select the page setup options: Paper Size and Orientation.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.
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7. Select any application-specific settings that appear on the screen, such as those shown in the image
above for the Preview application.

8. Select Print Settings from the pop-up menu.

You see these settings:
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9. Select the type of paper you loaded as the Media Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

10. Select the Print Quality setting you want to use.
11. Select any of the available print options.
Print Quality Settings - Mac OS X 10.5/10.6/10.7
Print Options - Mac OS X 10.5/10.6/10.7
Parent topic: Printing with Mac OS X 10.5, 10.6, or 10.7
Related references
Paper or Media Type Settings
Related tasks
Selecting Page Setup Settings - Mac OS X 10.5/10.6/10.7
Printing Your Document or Photo - Mac OS X 10.5/10.6/10.7
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Print Quality Settings - Mac OS X 10.5/10.6/10.7
You can select any of the print quality settings to fine-tune the quality of your print. Some settings may
be unavailable, depending on the paper type and border setting you have chosen.
Economy

For fast printing with reduced quality.
Normal

For everyday text and image printing.
Fine

For text and graphics with good quality and print speed.
Photo

For photos and graphics with good quality and print speed.
Photo RPM

For the best print quality, but the slowest print speed.
Parent topic: Selecting Basic Print Settings - Mac OS X 10.5/10.6/10.7

Print Options - Mac OS X 10.5/10.6/10.7
You can select any of the print options to customize your print. Some options may be unavailable,
depending on other settings you have chosen.
Expansion

If you selected a borderless paper size setting, adjusts the image expansion settings to control
printing at the edges of borderless prints.

Grayscale
Prints text and graphics in black or shades of gray.

Mirror Image
Lets you flip the printed image horizontally.

Note: If you select the Min option for the Expansion setting, you may see white borders on your printed
photo.

Parent topic: Selecting Basic Print Settings - Mac OS X 10.5/10.6/10.7

Selecting Page Setup Settings - Mac OS X 10.5/10.6/10.7
Depending on your application, you may be able to select the paper size and orientation settings from
the print window.
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Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

1. Select the size of the paper you loaded as the Paper Size setting. If you are printing a borderless
photo, select a paper size with a Sheet Feeder - Borderless option. You can also select a custom
setting to create a custom paper size.

Note: You must select a compatible borderless paper type and size to print borderlessly. Check the
borderless paper compatibility list for details.

2. Select the orientation of your document or photo as shown in the print window.

Note: If you are printing an envelope, select the icon.

Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the
pop-up menu and selecting a scaling option.

Parent topic: Printing with Mac OS X 10.5, 10.6, or 10.7
Related references
Borderless Paper Type Compatibility

Selecting Print Layout Options - Mac OS X 10.5/10.6/10.7
You can select a variety of layout options for your document or photo by selecting Layout from the pop-
up menu on the print window.
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• To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet
pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.

• To print borders around each page on the sheet, select a line setting from the Border pop-up menu.
• To invert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.
Parent topic: Printing with Mac OS X 10.5, 10.6, or 10.7

Managing Color - Mac OS X 10.5/10.6/10.7
You can adjust the Color Matching and Color Options settings to fine-tune the colors in your printout, or
turn off color management in your printer software.
1. Select Color Matching from the pop-up menu in the print window.

2. Select one of the available options.
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3. Select Color Options from the pop-up menu in the print window.

Note: The available settings on the Color Options menu depend on the option you selected on the
Color Matching menu.

4. Select one of the available options.
Color Matching and Color Options - Mac OS X 10.5/10.6/10.7
Parent topic: Printing with Mac OS X 10.5, 10.6, or 10.7

Color Matching and Color Options - Mac OS X 10.5/10.6/10.7
You can select from these settings on the Color Matching and Color Options menus.

Color Matching Settings
EPSON Color Controls

Lets you manage color using controls in your printer software, or turn off color management.
ColorSync

Prints using standard color profiles for your product and paper to help match image colors. You can
customize the conversion method and filter settings on the ColorSync pop-up menu in the print
window.
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Color Options Settings
Manual Settings

Lets you select manual color adjustments. Click the arrow next to Advanced Settings and select
settings for Brightness, Contrast, Saturation, and individual color tones. You can also select a color
Mode setting for printing photos and graphics. If you select the Adobe RGB color mode, you can also
adjust the midtone density using the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to
retain the special color effects.

Off (No Color Adjustment)
Turns off color management in your printer software so you can manage color using only your
application software.

Parent topic: Managing Color - Mac OS X 10.5/10.6/10.7

Selecting Printing Preferences - Mac OS X 10.5/10.6/10.7
You can select printing preferences that apply to all the print jobs you send to your product.
1. In the Apple menu or the Dock, select System Preferences.
2. Select Print & Fax or Print & Scan, select your product, and select Options & Supplies.
3. Select Driver.

You see this screen:
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4. Select any of the available printing preferences.
5. Click OK.
Printing Preferences - Mac OS X 10.5/10.6/10.7
Parent topic: Printing with Mac OS X 10.5, 10.6, or 10.7

Printing Preferences - Mac OS X 10.5/10.6/10.7
You can select from these settings on the Driver tab.
Thick paper and envelopes

Prevents ink from smearing when you print on envelopes or other thick paper.
Skip Blank Page

Ensures that your product does not print pages that contain no text or images.
High Speed Printing

Speeds up printing, but may reduce print quality.
Parent topic: Selecting Printing Preferences - Mac OS X 10.5/10.6/10.7

Printing Your Document or Photo - Mac OS X 10.5/10.6/10.7
Once you have selected your print settings, you are ready to print.
Click Print at the bottom of the print window.
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Checking Print Status - Mac OS X 10.5/10.6/10.7
Parent topic: Printing with Mac OS X 10.5, 10.6, or 10.7

Checking Print Status - Mac OS X 10.5/10.6/10.7
During printing, you can view the progress of your print job, control printing, and check ink cartridge
status.
1. Click the printer icon when it appears in the Dock.

You see the print status window:
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2. Select the following options as necessary:
• To cancel printing, click the print job and click Delete.
• To pause a print job, click the print job and click Hold. To resume a print job, click the print job

marked "Hold" and click Resume.
• To pause printing for all queued print jobs, click Pause Printer.
• To check ink status, click Supply Levels.

Parent topic: Printing Your Document or Photo - Mac OS X 10.5/10.6/10.7

Printing with Mac OS X 10.4
You can print with your product using any Mac OS X printing program, as described in these sections.
Selecting Page Setup Settings - Mac OS X 10.4
Selecting Basic Print Settings - Mac OS X 10.4
Selecting Print Layout Options - Mac OS X 10.4
Managing Color - Mac OS X 10.4
Selecting Printing Preferences - Mac OS X 10.4
Printing Your Document or Photo - Mac OS X 10.4
Parent topic: Printing From a Computer
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Selecting Page Setup Settings - Mac OS X 10.4
Select the page setup settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the Page Setup command in your application.

Note: You may need to select a print icon on your screen, the Page Setup option in the File menu,
or another command. See your application's help utility for details.

3. Select your product as the Format for setting.

4. Select the size of the paper you loaded as the Paper Size setting. If you are printing a borderless
photo, select a paper size with a Sheet Feeder - Borderless option. You can also select a custom
setting to create a custom paper size.

Note: You must select a compatible borderless paper type and size to print borderlessly. Check the
borderless paper compatibility list for details.
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5. Select the orientation of your document or photo as shown in the page setup window.

Note: If you are printing an envelope, select the icon.

6. To reduce or enlarge the size of the printed image, select a different Scale setting.
7. Click OK to close the window.
Parent topic: Printing with Mac OS X 10.4
Related references
Borderless Paper Type Compatibility
Related tasks
Selecting Basic Print Settings - Mac OS X 10.4

Selecting Basic Print Settings - Mac OS X 10.4
Select the basic settings for the document or photo you want to print.
1. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

2. Select your product as the Printer setting.
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3. Select the Copies and Pages settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before
printing. In some applications, you may need to select Advanced before you can see these settings.

4. Select Print Settings from the pop-up menu.

5. Select the type of paper you loaded as the Media Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

6. Select the Print Quality setting you want to use.
7. Select any of the available print options.
Print Quality Settings - Mac OS X 10.4
Print Options - Mac OS X 10.4
Parent topic: Printing with Mac OS X 10.4
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Related references
Paper or Media Type Settings
Related tasks
Printing Your Document or Photo - Mac OS X 10.4

Print Quality Settings - Mac OS X 10.4
You can select any of the print quality settings to fine-tune the quality of your print. Some settings may
be unavailable, depending on the paper type and border setting you have chosen.
Economy

For fast printing with reduced quality.
Normal

For everyday text and image printing.
Fine

For text and graphics with good quality and print speed.
Photo

For photos and graphics with good quality and print speed.
Photo RPM

For the best print quality, but the slowest print speed.
Parent topic: Selecting Basic Print Settings - Mac OS X 10.4

Print Options - Mac OS X 10.4
You can select any of the print options to customize your print. Some options may be unavailable,
depending on other settings you have chosen.
Expansion

If you selected a borderless paper size setting, adjusts the image expansion settings to control
printing at the edges of borderless prints.

Grayscale
Prints text and graphics in black or shades of gray.

Mirror Image
Lets you flip the printed image horizontally.

Note: If you select the Min option for the Expansion setting, you may see white borders on your printed
photo.

Parent topic: Selecting Basic Print Settings - Mac OS X 10.4
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Selecting Print Layout Options - Mac OS X 10.4
You can select layout options for multi-page documents by selecting Layout from the pop-up menu on
the print window.

• To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet
pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.

• To print borders around each page on the sheet, select a line setting from the Border pop-up menu.
Parent topic: Printing with Mac OS X 10.4

Managing Color - Mac OS X 10.4
You can adjust the Color Options settings to fine-tune the colors in your printout, or turn off color
management in your printer software.
1. Select Color Options from the pop-up menu in the print window.
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2. Select one of the available options.
Color Options - Mac OS X 10.4
Parent topic: Printing with Mac OS X 10.4

Color Options - Mac OS X 10.4
You can select from these settings on the Color Options menu.
Manual Settings

Lets you select manual color adjustments. Click the arrow next to Advanced Settings and select
settings for Brightness, Contrast, Saturation, and individual color tones. You can also select a color
Mode setting for printing photos and graphics. If you select the Adobe RGB color mode, you can also
adjust the midtone density using the Gamma setting.

ColorSync
Prints using standard color profiles for your product and paper to help match image colors. You can
customize the conversion method and filter settings on the ColorSync pop-up menu in the print
window.

Off (No Color Adjustment)
Turns off color management in your printer software so you can manage color using only your
application software.

Parent topic: Managing Color - Mac OS X 10.4

Selecting Printing Preferences - Mac OS X 10.4
You can select various printing preferences from the Extension Settings menu.
1. Select Extension Settings from the pop-up menu in the print window.
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2. Select any of the available printing preferences.
Printing Preferences - Mac OS X 10.4
Parent topic: Printing with Mac OS X 10.4

Printing Preferences - Mac OS X 10.4
You can select from these options on the Extension Settings menu.
Thick paper and envelopes

Prevents ink from smearing when you print on envelopes or other thick paper.
Skip Blank Page

Ensures that your product does not print pages that contain no text or images.
High Speed Printing

Speeds up printing, but may reduce print quality.
Parent topic: Selecting Printing Preferences - Mac OS X 10.4

Printing Your Document or Photo - Mac OS X 10.4
Once you have selected your print settings, you are ready to print.
Click Print at the bottom of the print window.
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Checking Print Status - Mac OS X 10.4
Parent topic: Printing with Mac OS X 10.4

Checking Print Status - Mac OS X 10.4
During printing, you can view the progress of your print job, control printing, and check ink cartridge
status.
1. Click the printer icon when it appears in the Dock.

You see the print status window:
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2. Select the following options as necessary:
• To cancel printing, click the print job and click Delete.
• To pause printing, click the print job and click Hold. To resume printing, click the print job marked

"Hold" and click Resume.
• To check ink status, click Supply Levels.

Parent topic: Printing Your Document or Photo - Mac OS X 10.4

Cancelling Printing Using a Product Button
If you need to cancel printing, press the paper/cancel button on your product for 3 seconds.
Parent topic: Printing From a Computer
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Using an External Device with Your Product
Follow the instructions in these sections to use your product with an external device, such as a camera,
smartphone, or other device.
Wireless Printing from a Mobile Device
Printing From a Camera Connected to Your Product

Wireless Printing from a Mobile Device
You can print photos, documents, web pages, and more from smartphones or tablets, such as iPhones,
iPads, and Android devices.
1. Set up your product for wireless printing as described on the Start Here sheet.
2. Visit www.epson.com/connect to learn more about mobile device printing and check the compatibility

of your mobile device.
3. Connect your mobile device to the same wireless network that your product is using.
4. Print from your mobile device to your EPSON product.
Parent topic: Using an External Device with Your Product

Printing From a Camera Connected to Your Product
If you have a digital camera that supports PictBridge printing, you can connect it to the product and print
your photos directly from the camera. Check your camera manual to see if it is compatible.

Note: Your photos must be in JPG format and sized from 80 × 80 to 9200 × 9200 pixels. Epson cannot
guarantee the compatibility of your camera. Some combinations of paper type, size, and layout may not
be supported, depending on your camera and the product settings.

1. Load the paper you want to use for printing.
2. Connect the USB cable that came with your camera to the USB port on the front of your product.

Note: You cannot use the USB port to transfer images from your camera to your computer.
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3. Turn on your camera.
4. Follow the instructions that came with your camera to select your photos and settings, and print.
When you finish printing, turn off your camera and disconnect it from the product.
Parent topic: Using an External Device with Your Product
Related tasks
Loading Paper
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Printing on CDs/DVDs
Follow the instructions here to print a design onto ink jet-printable CDs or DVDs to create a custom label.
Loading a CD/DVD
Removing a Printed CD/DVD
Printing on CDs/DVDs from a Computer

Loading a CD/DVD
You can print on any compatible, ink jet-printable CDs or DVDs (including Blu-ray Discs), preferably with
a white surface.

Note: If you are using discs where the printable area extends to within 0.16 inch (4 mm) of the center
hole, you may need to adjust the inner diameter setting using the EPSON Print CD software.

1. Make sure you burn your files, music, or video onto your disc before printing on it.
2. Turn on the product.
3. Remove any paper loaded in the sheet feeder, and close the paper support if it's open.
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4. Open the output tray, but do not pull out the extensions. Then open the CD/DVD feed tray.
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5. Place your disc on the included CD/DVD tray with the label side up.

1 12-cm discs
2 8-cm discs

Note: For small 8-cm discs, place the adapter on the tray and then place the disc in the adapter.

Caution: Before placing the CD/DVD, make sure no foreign particles or substances are on the
CD/DVD tray. Otherwise, the CD/DVD and the data on it may be damaged.

68



6. Gently insert the CD/DVD tray into the CD/DVD feed tray. Push in the tray until the arrows on the
tray and feed tray are aligned.

Caution: Do not insert the CD/DVD tray while the power light is flashing. Otherwise, the product
or your CD/DVD may be damaged. Do not turn off the product with the CD/DVD tray inserted in it.
Always remove the tray first.

Parent topic: Printing on CDs/DVDs
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Removing a Printed CD/DVD
After your CD/DVD is printed, the CD/DVD tray ejects partially from the product. Pull out the tray and
remove the disc. Then close the CD/DVD feed tray.

Note: If the CD/DVD tray gets any ink on it, immediately wipe it off.

After printing, handle the CD/DVD carefully. You may need to wait up to 24 hours for the ink to dry fully
before inserting it in a drive, depending on the type of disc you used. Keep printed discs away from
moisture and direct sunlight.

Caution: Do not turn off the product with the CD/DVD tray inserted in it. Always remove the tray first.
Store the CD/DVD tray flat. A warped or damaged CD/DVD tray may stop your product from operating
normally.

Parent topic: Printing on CDs/DVDs

Printing on CDs/DVDs from a Computer
Before printing directly on CDs or DVDs from your computer, make sure you have set up your product
and installed the EPSON Print CD software as described on the Start Here sheet.

Note: Use only an application that supports CD/DVD printing or ink may get on the CD/DVD tray or
inside your product. Check the CD/DVD package for any additional instructions.

Printing on a CD/DVD with Windows
Printing on a CD/DVD with Mac OS X
Parent topic: Printing on CDs/DVDs

Printing on a CD/DVD with Windows
You can print with your product using the EPSON Print CD software, as described in these sections.
Designing a CD/DVD - Windows
Printing Your CD/DVD Design - Windows
Adjusting CD/DVD Print Position - Windows
Adjusting CD/DVD Print Quality - Windows
Parent topic: Printing on CDs/DVDs from a Computer
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Designing a CD/DVD - Windows
You can use EPSON Print CD to design your disc by importing photos, adding text, and creating special
effects.
1. Open the EPSON Print CD program on your computer.

You see this screen:

2. Use the buttons on the left side of the screen to select a pre-designed template or add a background
image, picture, text, or graphic elements. For more information, select the Help menu.

3. When you are finished creating your design, click Save and save your design file.
Parent topic: Printing on a CD/DVD with Windows
Related tasks
Printing Your CD/DVD Design - Windows

Printing Your CD/DVD Design - Windows
After you create your design, you can print it on paper to test it, then print it on the CD or DVD that
contains your data, photos, video, or music. Make sure the disc is loaded for printing before you start.
1. Open your file in EPSON Print CD and click Print.

You see this screen:
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2. Make sure your product is selected as the Printer setting.
3. To see how your design will look without printing on the disc, click Test Print and follow the

instructions on the screen.

Note: If printing a test design on a sheet of paper, make sure that the CD/DVD tray is not inserted in
the product and the CD/DVD feed tray is closed.

4. When you are ready to print on the disc, click the Print button on the screen.
5. Click Print.
Parent topic: Printing on a CD/DVD with Windows

Adjusting CD/DVD Print Position - Windows
If your printed design is not positioned correctly on the disc, you can adjust the print position. First, load
an extra CD/DVD to use for printing test patterns.
1. Open your file in EPSON Print CD and click Print.

You see this screen:
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2. Select Print Position Confirmation Pattern.
3. Click Print.
4. Remove the disc after printing.
5. Using a metric ruler, measure the distance from the hole to the cross marks labeled Top and Right.

Note: Be sure to measure from the edge of the hole and not the edge of the printable area.

6. Click Print again, then select Adjust Print Position.
You see this screen:
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7. Click Enter Values, then select the distance for Top into the Height (Top) box and the distance for
Right in the Width (Right) box.

8. Click OK.
Parent topic: Printing on a CD/DVD with Windows
Related tasks
Printing Your CD/DVD Design - Windows

Adjusting CD/DVD Print Quality - Windows
If ink smears on your disc or is sticky after it dries, you can adjust the color saturation and ink density.
This may be necessary to make sure your designs look their best on the particular brand of discs you are
using. First, load an extra CD/DVD to use for printing test patterns.
1. Open your file in EPSON Print CD and click Print.

You see this screen:
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2. Select Print Density Confirmation Pattern.
3. Click Print.
4. Remove the disc after printing and check to see if you need to make the density darker or lighter.
5. Load the same disc in the product again.
6. Click Print.
7. Adjust the Print Color Correction slider to a darker or lighter setting as necessary.
8. Select Print Density Confirmation Pattern and select the Second radio button.
9. Click Print to print another test pattern
10. Examine the disc after printing to see if further adjustment is needed.
When the ink density looks good, you are ready to print on your burned CD or DVD.
Parent topic: Printing on a CD/DVD with Windows
Related tasks
Printing Your CD/DVD Design - Windows
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Printing on a CD/DVD with Mac OS X
You can print with your product using the EPSON Print CD software, as described in these sections.
Designing a CD/DVD - Mac OS X
Printing Your CD/DVD Design - Mac OS X
Adjusting CD/DVD Print Position - Mac OS X
Adjusting CD/DVD Print Quality - Mac OS X
Parent topic: Printing on CDs/DVDs from a Computer

Designing a CD/DVD - Mac OS X
You can use EPSON Print CD to design your disc by importing photos, adding text, and creating special
effects.
1. Open the EPSON Print CD program in the Applications > Epson Software > Print CD folder on

your Mac.
You see this screen:
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2. Use the icons on the left side of the screen to add a background image, picture, text, or graphic
elements.

3. When you are finished creating your design, make sure you save it.
Parent topic: Printing on a CD/DVD with Mac OS X
Related tasks
Printing Your CD/DVD Design - Mac OS X

Printing Your CD/DVD Design - Mac OS X
After you create your design, you can print it on paper to test it, then print it on the CD or DVD that
contains your data, photos, video, or music. Make sure the disc is loaded for printing before you start.
1. Open your file in EPSON Print CD and select Print from the File menu.

You see this screen:

2. Make sure your product is selected as the Printer setting.
3. To see how your design will look without printing on the disc, select Test Print and follow the

instructions on the screen.
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Note: If printing a test design on a sheet of paper, make sure that the CD/DVD tray is not inserted in
the product and the CD/DVD feed tray is closed.

4. When you are ready to print on the disc, click the Print button on the screen.
Parent topic: Printing on a CD/DVD with Mac OS X

Adjusting CD/DVD Print Position - Mac OS X
If your printed design is not positioned correctly on the disc, you can adjust the print position. First, load
an extra CD/DVD to use for printing test patterns.
1. Open your file in EPSON Print CD and select Print from the File menu.

You see this screen:

2. Select Print Position Check Pattern.
3. Click Print.
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4. Remove the disc after printing.
5. Using a metric ruler, measure the distance from the hole to the cross marks labeled Top and Right.

Note: Be sure to measure from the edge of the hole and not the edge of the printable area.

6. Select Print from the File menu.
7. Select Position Adjustment.

You see this screen:

8. Click Value Entry, then select the distance for Top into the Top Space box and the distance for
Right in the Right Space box.

9. Click OK.
Parent topic: Printing on a CD/DVD with Mac OS X
Related tasks
Printing Your CD/DVD Design - Mac OS X
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Adjusting CD/DVD Print Quality - Mac OS X
If ink smears on your disc or is sticky after it dries, you can adjust the color saturation and ink density.
This may be necessary to make sure your designs look their best on the particular brand of discs you are
using. First, load an extra CD/DVD to use for printing test patterns.
1. Open your file in EPSON Print CD and select Print from the File menu.

You see this screen:

2. Select Print Density Check Pattern.
3. Click Print.
4. Remove the disc after printing and check to see if you need to make the density darker or lighter.
5. Load the same disc in the product again.
6. Select Print from the File menu.
7. Select a darker or lighter setting in the Color Correction box as necessary.
8. Select Print Density Check Pattern and select Second Time.
9. Click Print to print another test pattern.
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10. Examine the disc after printing to see if further adjustment is needed.
When the ink density looks good, you are ready to print on your burned CD or DVD.
Parent topic: Printing on a CD/DVD with Mac OS X
Related tasks
Printing Your CD/DVD Design - Mac OS X
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Replacing Ink Cartridges
When an ink cartridge is expended, you need to replace it.
You may also need to replace a cartridge that is more than six months old, if your printouts do not look
their best, even after cleaning and aligning the print head.

Note: Please dispose of your used EPSON branded ink cartridges responsibly and in accordance with
local requirements. If you would like to return your used ink cartridges to Epson for proper disposal,
please go to www.epson.com/recycle for more information.

Check Cartridge Status
Purchase EPSON Ink Cartridges
Removing and Installing Ink Cartridges

Check Cartridge Status
Your product and its printing software will let you know when an ink cartridge is low or expended.
Checking Cartridge Status Lights
Checking Cartridge Status with Windows
Checking Cartridge Status with Mac OS X
Parent topic: Replacing Ink Cartridges

Checking Cartridge Status Lights
You can check the status of your ink cartridges by checking the lights on your product.
• If the ink light is flashing, a cartridge is low. You can continue printing until the cartridge needs

replacement.
• If the ink light is on, a cartridge is expended. You must replace the cartridge before you can print.
Parent topic: Check Cartridge Status

Checking Cartridge Status with Windows
A low ink reminder appears if you try to print when ink is low, and you can check your cartridge status at
any time using a utility on your Windows computer.
1. To check your cartridge status, double-click the product icon in the Windows taskbar.

You see this window:
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2. Replace or reinstall any ink cartridge indicated on the screen.

Note: If any of the cartridges installed in the product is broken, incompatible with the product model,
or improperly installed, EPSON Status Monitor will not display an accurate cartridge status.

3. To disable the low ink reminder, right-click the product icon in the Windows taskbar and select
Monitoring Preferences.
You see this window:
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4. Deselect the See Low Ink Reminder alerts checkbox at the bottom of the screen.
5. To disable promotional offers, deselect the Display Epson Offers checkbox.
Parent topic: Check Cartridge Status
Related tasks
Removing and Installing Ink Cartridges
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Checking Cartridge Status with Mac OS X
You can check the status of your ink cartridges using a utility on your Mac.
1. Do one of the following:

• Mac OS X 10.6/10.7: In the Apple menu or the Dock, select System Preferences. Select Print &
Fax or Print & Scan, select your product, and select Options & Supplies. Select Utility and
select Open Printer Utility.

• Mac OS X 10.4/10.5: In the Apple menu or the Dock, select System Preferences. Select Print &
Fax, select your product, and select Open Print Queue or Print Queue. Select Utility.

2. Select EPSON Status Monitor.
You see this window:
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3. Do the following as necessary:
• You can update the ink cartridge status by clicking Update.
• Replace or reinstall any ink cartridge indicated on the screen.

Note: If any of the cartridges installed in the product is broken, incompatible with the product model,
or improperly installed, EPSON Status Monitor will not display an accurate cartridge status.

Parent topic: Check Cartridge Status
Related tasks
Removing and Installing Ink Cartridges

Purchase EPSON Ink Cartridges
You can purchase genuine EPSON ink and paper at EPSON Supplies Central at www.epson.com/ink3
(U.S. sales) or www.epson.ca (Canadian sales). You can also purchase supplies from an EPSON
authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).

Note: We recommend that you use genuine EPSON cartridges and do not refill them. The use of other
products may affect your print quality and could result in printer damage.
The printer ships with full cartridges and part of the ink from this first set of cartridges is used for priming
the printer. Yields vary considerably based on images printed, print settings, paper type, frequency of
use, and temperature. For print quality, a variable amount of ink remains in the cartridge after the
"replace cartridge" indicator comes on.

Ink Cartridge Part Numbers
Parent topic: Replacing Ink Cartridges

Ink Cartridge Part Numbers
Use these part numbers when you order or purchase new ink cartridges, and use the cartridges within
six months of installing them.

Ink color Part number (High Capacity)
Black 79
Cyan 79
Magenta 79
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Ink color Part number (High Capacity)
Yellow 79
Light Magenta 79
Light Cyan 79

Parent topic: Purchase EPSON Ink Cartridges

Removing and Installing Ink Cartridges
Make sure you have your replacement cartridges handy before you begin. You must install new
cartridges immediately after removing the old ones.

Caution: Leave your old cartridges in the product until you are ready to replace them to prevent the print
head nozzles from drying out. Do not open ink cartridge packages until you are ready to install the ink.
Cartridges are vacuum packed to maintain reliability.

1. Make sure the CD/DVD tray is not inserted in the product, and the power light is on but not
flashing.

2. Open the printer cover.
3. Press the ink button to move the print head to the ink replacement position.

If a cartridge is expended, a solid light appears above it.
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Note: If an ink cartridge is low, a flashing light appears above it. You can continue to use the low ink
cartridge until it is expended. Do not hold the ink button for more than three seconds, or the
product may start cleaning the print head.

Caution: Do not move the print head by hand; otherwise, you may damage your product. Do not
touch the flat white cable inside the product.
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4. Open the ink cartridge cover.

5. Squeeze the tab on the cartridge and lift the cartridge straight up to remove it.

Note: Dispose of used cartridges carefully. Do not take the used cartridge apart or try to refill it.

Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes,
flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away.
Keep ink cartridges out of the reach of children.
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6. Remove the cartridge from the package.

Caution: Do not touch the green chip on the cartridge. Install the new cartridge immediately after
removing the old one; if you do not, the print head may dry out and be unable to print.

7. Remove the yellow tape from the bottom of the cartridge.

Caution: Do not remove any other labels or seals, or ink will leak.
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8. Insert the new cartridge into the holder and push it down until it clicks into place.

9. Once you replace all the cartridges that need replacing, close the cartridge cover and the printer
cover.

10. Press the ink button to begin charging the ink. This takes about 2 minutes.
When the power light stops flashing and remains on, ink charging is finished.

Caution: Never turn off the product while the power light is flashing or you will waste ink.

Note: If the ink light is on after the print head moves to its home position, the ink cartridge may not
be installed properly. Press the ink button again, and press down the ink cartridge until it clicks into
place.

If you remove a low or expended ink cartridge, you cannot re-install and use the cartridge.
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Caution: If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and
store it in the same environment as the printer. The valve in the ink supply port is designed to contain
any excess ink, but do not touch the ink supply port or surrounding area. Always store ink cartridges with
the label facing up; do not store cartridges upside-down.

Parent topic: Replacing Ink Cartridges
Related concepts
Purchase EPSON Ink Cartridges
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Adjusting Print Quality
If your print quality declines, you may need to run a utility to clean or align the print head.
If running these utilities does not solve the problem, you may need to replace the ink cartridges.
Print Head Maintenance
Print Head Alignment
Cleaning the Paper Path
Related topics
Replacing Ink Cartridges

Print Head Maintenance
If your printouts become too light, or you see dark or light bands across them, you may need to clean the
print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.
You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.

Note: You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it
when a cartridge is low. You must replace the cartridge first.

Print Head Nozzle Check
Print Head Cleaning
Parent topic: Adjusting Print Quality
Related topics
Replacing Ink Cartridges

Print Head Nozzle Check
You can print a nozzle check pattern to check for clogged nozzles.
Checking the Nozzles Using the Product Buttons
Checking the Nozzles Using a Computer Utility
Parent topic: Print Head Maintenance

Checking the Nozzles Using the Product Buttons
You can check the print head nozzles using the buttons on your product.
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1. Make sure that no product lights indicate errors, the CD/DVD tray is not inserted in the product, and
the CD/DVD feed tray is closed.

2. Load a few sheets of plain paper in the product.
3. Turn off the product.
4. Hold down the paper/cancel button as you press the power button to turn the product back

on. Hold down both buttons until the power light begins to flash, then release the buttons.

5. Check the printed pattern to see if there are gaps in the lines.
Print head is clean
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Print head needs cleaning

6. If there are no gaps, the print head is clean and you can continue printing.
If there are gaps or the pattern is faint, clean the print head.

Parent topic: Print Head Nozzle Check
Related concepts
Print Head Cleaning

Checking the Nozzles Using a Computer Utility
You can check the print head nozzles using a utility on your Windows or Mac computer.
1. Make sure that no product lights indicate errors, the CD/DVD tray is not inserted in the product, and

the CD/DVD feed tray is closed.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:

• Windows: Right-click the product icon in the Windows taskbar.
• Mac OS X 10.6/10.7: In the Apple menu or the Dock, select System Preferences. Select Print &

Fax or Print & Scan, select your product, and select Options & Supplies. Select Utility and
select Open Printer Utility.

• Mac OS X 10.4/10.5: In the Apple menu or the Dock, select System Preferences. Select Print &
Fax or Print & Scan, select your product, and select Open Print Queue or Print Queue. Select
Utility.

4. Select Nozzle Check.
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You see one of these windows:
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5. Click Print.
6. Check the printed pattern to see if there are gaps in the lines.

Print head is clean

Print head needs cleaning
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7. If there are no gaps, click Finish.
If there are gaps or the pattern is faint, clean the print head.

Parent topic: Print Head Nozzle Check
Related concepts
Print Head Cleaning

Print Head Cleaning
If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the
print head.

Note: You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it
when a cartridge is low. You must replace the cartridge first.

Cleaning the Print Head Using the Product Buttons
Cleaning the Print Head Using a Computer Utility
Parent topic: Print Head Maintenance
Related topics
Replacing Ink Cartridges

Cleaning the Print Head Using the Product Buttons
You can clean the print head using the buttons on your product.
1. Make sure that no product lights indicate errors, the CD/DVD tray is not inserted in the product, and

the CD/DVD feed tray is closed.
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2. Hold down the ink button for 3 seconds to start the cleaning cycle, which lasts around 1 minute.

The power light flashes throughout the cleaning cycle and stays on when the cleaning cycle is
finished.

Caution: Never turn off the product during a cleaning cycle or you may damage it.

3. Load a few sheets of plain paper in the product.
4. Run a nozzle check to confirm that the print head is clean.
If you don’t see any improvement after cleaning the print head up to 4 times, turn off the product and wait
at least 6 hours. Then try cleaning the print head again. If quality still does not improve, one of the ink
cartridges may be old or damaged and needs to be replaced.
Parent topic: Print Head Cleaning
Related concepts
Print Head Nozzle Check
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Related topics
Replacing Ink Cartridges

Cleaning the Print Head Using a Computer Utility
You can clean the print head using a utility on your Windows or Mac computer.
1. Make sure that no product lights indicate errors, the CD/DVD tray is not inserted in the product, and

the CD/DVD feed tray is closed.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:

• Windows: Right-click the product icon in the Windows taskbar.
• Mac OS X 10.6/10.7: In the Apple menu or the Dock, select System Preferences. Select Print &

Fax or Print & Scan, select your product, and select Options & Supplies. Select Utility and
select Open Printer Utility.

• Mac OS X 10.4/10.5: In the Apple menu or the Dock, select System Preferences. Select Print &
Fax, select your product, and select Open Print Queue or Print Queue. Select Utility.

4. Select Head Cleaning.
You see one of these windows:
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5. Click Start to begin the cleaning cycle.
The power light flashes throughout the cleaning cycle and stays on when the cleaning cycle is
finished.

Caution: Never turn off the product during a cleaning cycle or you may damage it.

6. When the power light stops flashing and remains on, you can check to see if the nozzles are
clean; click Print Nozzle Check Pattern and click Print.

7. Check the printed pattern to see if there are gaps in the lines.
Print head is clean
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Print head needs cleaning

• If there are no gaps, click Finish.
• If there are gaps or the pattern is faint, click Clean to clean the print head again.

If you don’t see any improvement after cleaning the print head up to 4 times, turn off the product and wait
at least 6 hours. Then try cleaning the print head again. If quality still does not improve, one of the ink
cartridges may be old or damaged and needs to be replaced.
Parent topic: Print Head Cleaning
Related topics
Replacing Ink Cartridges

Print Head Alignment
If your printouts become grainy or blurry, you notice misalignment of vertical lines, or you see dark or
light horizontal bands, you may need to align the print head.

Note: Banding may also occur if your print head nozzles need cleaning.

Aligning the Print Head Using a Computer Utility
Parent topic: Adjusting Print Quality
Related concepts
Print Head Cleaning
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Aligning the Print Head Using a Computer Utility
You can align the print head using a utility on your Windows computer or Mac.
1. Make sure that no product lights indicate errors, the CD/DVD tray is not inserted in the product, and

the CD/DVD feed tray is closed.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:

• Windows: Right-click the product icon in the Windows taskbar.
• Mac OS X 10.6/10.7: In the Apple menu or the Dock, select System Preferences. Select Print &

Fax or Print & Scan, select your product, and select Options & Supplies. Select Utility and
select Open Printer Utility.

• Mac OS X 10.4/10.5: In the Apple menu or the Dock, select System Preferences. Select Print &
Fax, select your product, and select Open Print Queue or Print Queue. Select Utility.

4. Select Print Head Alignment.
5. Click Next, then click Print to print an alignment sheet.

Note: Do not cancel printing while you are printing a head alignment pattern.

You see one of these windows:
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6. Check the printed pattern and follow the instructions on the screen to choose the number
representing the best printed pattern for each set.

7. When you are done choosing each pattern number, click Finish.
If no patterns are aligned in one or more of the sets, choose the closest one in each set and click
Realignment. Then print another alignment sheet and check it.

Parent topic: Print Head Alignment

Cleaning the Paper Path
If you see ink on the back of a printout, you can clean the paper path to remove any excess ink.
1. Make sure that no product lights indicate errors, the CD/DVD tray is not inserted in the product, and

the CD/DVD feed tray is closed.
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2. Load several sheets of A3-size paper, if available. Otherwise, load several sheets of plain paper.
3. Press the paper/cancel button to feed and eject paper.
4. Repeat as necessary until the paper comes out clean.
Parent topic: Adjusting Print Quality
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Cleaning and Transporting the Product
If your product gets dirty or you need to move it some distance, follow the instructions in these sections.
Cleaning the Product
Transporting the Product

Cleaning the Product
To keep the product working at its best, you should clean it several times a year.

Caution: Do not use a hard brush, benzine, alcohol, or paint thinner to clean the product or you may
damage it. Do not place anything on top of the cover or use the cover as a writing surface, or it could get
permanently scratched. Do not use oil or other lubricants inside the product or let water get inside.

1. Turn off the product.
2. Unplug the power cable.
3. Disconnect any connected cables.
4. Remove any paper from the product.
5. Clean the sheet feeder and paper support using a soft brush or a soft, lint-free cloth (microfiber is

recommended).
6. Clean the outer case with a soft cloth dampened with a mild detergent.
7. Plug the power cable back in, and turn on the product.
8. Clean the paper path, if necessary.

Note: Close the paper support and the output tray when you are not using the product to protect it from
dust.

Parent topic: Cleaning and Transporting the Product
Related tasks
Cleaning the Paper Path

Transporting the Product
If you need to ship your product or transport it a long distance, prepare it for transportation as follows.
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1. Turn off the product.
2. Unplug the power cable.
3. Disconnect any connected cables.
4. Remove any paper from the product.
5. Open the printer cover and check that the ink cartridge holder is all the way to the right (the home

position). If necessary, plug in and turn on the product, then turn it off again using the power
button after the ink cartridge holder is in the home position.

6. Fasten the ink cartridge holder to the case using tape. Leave the ink cartridges installed to avoid
damaging the product.

Note: Some tape may be difficult to remove if left in place for a long time. Remove the tape
immediately after transporting the product.
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7. Close the printer cover and output tray, then secure both sides of the output tray to the outer case
with tape as shown.

8. Pack the product in its original box or one of a similar size using the protective materials that came
with it.

9. Keep the product level during transportation; otherwise the ink may leak.
10. After unpacking the product, remove the tape securing the ink cartridge holder and output tray.
If print quality has declined when you print again in a new location, clean and align the print head.
Parent topic: Cleaning and Transporting the Product
Related concepts
Print Head Cleaning
Print Head Alignment
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Solving Problems
Check these sections for solutions to problems you may have using your product.
Checking for Software Updates
Printer Light Status
Running a Printer Check
Solving Setup Problems
Solving Network Problems
Solving Paper Problems
Solving Problems Printing from a Computer
Solving Page Layout and Content Problems
Solving Print Quality Problems
When to Uninstall Your Product Software
Where to Get Help

Checking for Software Updates
Periodically, it's a good idea to check Epson's support website for free updates to your product software.
You can select Download the Latest Software from the Home screen of this manual or visit Epson's
driver download site (U.S. downloads or Canadian downloads).
With Windows, your printer software automatically checks for updates. You can also manually update
the software by selecting Driver Update here:
• Right-clicking the product icon in the Windows taskbar
• On the Maintenance tab in the printer settings window
• In the EPSON program group under your product name
Parent topic: Solving Problems

Printer Light Status
You can often diagnose problems with your printer by checking the printer lights.
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Lights
1 WiFi
2 power
3 paper/cancel
4 ink

Light status Condition/solution
The printer is turned on.The power light is on

The power light is The printer is busy. Wait for the power light to stop flashing before turning
flashing off the printer.
The WiFi light is green The printer is connected to the wireless network.
The WiFi light is orange Wi-Fi connection error. Press the Wi-Fi button to clear the error and try to

connect again.
Paper may be out. Load more paper in the sheet feeder and press theThe paper/cancel

light is on paper/cancel button to continue.
If multiple sheets have fed, press the paper/cancel button to eject the
paper.
If printing on a CD or DVD, the CD/DVD tray is not inserted correctly. Load
the CD/DVD tray correctly and press the paper/cancel button.
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Light status Condition/solution
Paper has jammed in the printer or the output tray is closed. Remove anyThe paper/cancel
jammed paper and make sure the output tray is open, then press thelight is flashing

paper/cancel to resume printing.
If printing on a CD or DVD, the CD/DVD tray did not eject correctly. Pull out
the CD/DVD tray and press the paper/cancel button.

The ink light is on An ink cartridge is not installed, installed incorrectly, expended, or cannot be
used with the printer. Make sure all ink cartridges are installed correctly and
replace any expended or incompatible ink cartridges.

The ink light is flashing An ink cartridge is low. Make sure you have a replacement cartridge.
The print head is obstructed by jammed paper or another foreign object andThe power light is off,
cannot return to the home position. Turn the printer off. Open the printerand the
cover and remove any paper or other obstructions from the paper path. Thenpaper/cancel and
turn the printer back on. If the error does not clear, contact Epson.ink lights are flashing

fast
The printer's ink pads are nearing or at the end of their service life. ContactThe paper/cancel
Epson to replace the ink pads. If the ink pads are nearing the end of theirand ink lights are

flashing alternately service life, printing can be resumed by pressing the paper/cancel
button.
The firmware update has failed, and the printer is in recovery mode. VisitThe paper/cancel
Epson's support website at www.epson.com/support (U.S.) orand ink lights are on
www.epson.ca/support (Canada) for instructions on repeating the firmware
update.

Parent topic: Solving Problems
Related concepts
Check Cartridge Status
Related references
Paper Jam Problems
Where to Get Help
Related topics
Replacing Ink Cartridges
Loading Paper
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Running a Printer Check
Running a printer check helps you determine if the printer is operating properly.
1. Make sure that the CD/DVD tray is not inserted in the product and the CD/DVD feed tray is closed.
2. Load a few sheets of plain paper in the product.
3. Turn off the product.
4. Disconnect any connected interface cables.
5. Hold down the paper/cancel button as you press the power button to turn the product back

on. Hold down both buttons until the power light begins to flash, then release the buttons.

The printer begins printing a nozzle check pattern.
6. Do the following, depending on the results of the printer check:

• If the page prints and the nozzle check pattern is complete, the printer is operating properly. Any
printing problem you may have could be caused by your computer, cable, software, or selected
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print settings. Check the other solutions in this section or try uninstalling and reinstalling your
printer software.

• If the page prints but the nozzle check pattern has gaps, clean or align the print head.
• If the page does not print, the printer may have a problem. Check the other solutions in this

manual. If they do not work, contact Epson.
Parent topic: Solving Problems
Related concepts
When to Uninstall Your Product Software
Print Head Cleaning
Print Head Alignment
Related references
Where to Get Help

Solving Setup Problems
Check these sections if you have problems while setting up your product.
Noise After Ink Installation
Software Installation Problems
Parent topic: Solving Problems

Noise After Ink Installation
If you hear noises from your product after installing ink, check these explanations:
• The first time you install ink cartridges, the product must prime its print head. Wait until priming

finishes before you turn off the product, or it may prime improperly and use excess ink the next time
you turn it on. Your product is finished priming the print head when the power light stops flashing.

• If the product's print head stops moving or making noise, and the charging process has not finished
after approximately 5 minutes, turn off your product. Turn it back on and check to see if charging is still
in progress. If it is still in progress, contact Epson for help.

Parent topic: Solving Setup Problems
Related topics
Replacing Ink Cartridges
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Software Installation Problems
If you have problems while installing your product software, try these solutions:
• Make sure your product is turned on and the USB cable is securely connected at both ends. If you still

have problems installing software, disconnect the cable and carefully follow the instructions on the
Start Here sheet. Also make sure your system meets the requirements for your operating system.

• Close any other programs, including screen savers and virus protection software, and install your
product software again.

• In Windows, make sure your product is selected as the default printer and the correct port is shown in
the printer properties.

• If you see any error message or your software does not install correctly in Windows, you may not have
software installation privileges. Contact your System Administrator.

Parent topic: Solving Setup Problems
Related concepts
When to Uninstall Your Product Software
Related references
Windows System Requirements
Mac System Requirements

Solving Network Problems
Check these solutions if you have problems setting up or using your product on a network.
Product Cannot Connect to a Wireless Router or Access Point
Network Software Cannot Find Product on a Network
Product Does Not Appear in Mac OS X Printer Window
Cannot Print Over a Network
Printing a Network Status Sheet
Parent topic: Solving Problems

Product Cannot Connect to a Wireless Router or Access Point
If your product has trouble finding or connecting to a wireless router or access point, try these solutions :
• Make sure to place your product within contact range of your router or access point.
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Note: Avoid placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal
object, such as a filing cabinet.

• Verify that your router or access point is operating correctly by connecting to it from your computer or
another device.

• You may need to disable the firewall and any anti-virus software on your wireless router or access
point.

• Check to see if access restrictions, such as MAC address filtering, are set on the router or access
point. If access restrictions are set, add your product's MAC address to your router's address list. To
obtain your product's MAC address, print a network status sheet. Then follow the instructions in your
router or access point documentation to add the address to the list.

• If your router or access point does not broadcast its network name (SSID), follow the instructions that
came with your product to enter your wireless network name manually.

• If your router or access point has security enabled, determine the kind of security it is using and any
required password or passphrase for connection. Then make sure to enter the exact WEP key or WPA
passphrase correctly.

Parent topic: Solving Network Problems

Network Software Cannot Find Product on a Network
If EpsonNet Setup cannot find your product on a network, try these solutions:
• Make sure your product is turned on and connected to your network. Verify connection using your

product control panel.
• If necessary, reinstall your product software and try running EpsonNet Setup again.
Parent topic: Solving Network Problems

Product Does Not Appear in Mac OS X Printer Window
If your product does not appear in the Mac OS X printer window, try these solutions:
• Turn your product off, wait 30 seconds, then turn it back on again.
• If you are connecting the product via Wi-Fi Protected Setup (WPS) and the WiFi light on your product

is not solid green, make sure you press the Wi-Fi button on the product within 2 minutes of pressing
the WPS button on your router. Hold down the Wi-Fi button on the product for 3 seconds.

• If you are connecting the product via EpsonNet Setup and the WiFi light on your product is not solid
green, make sure your product software was installed correctly. If necessary, reinstall your software.

Parent topic: Solving Network Problems
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Cannot Print Over a Network
If you cannot print over a network, try these solutions:
• Make sure that your product is turned on.
• Make sure you install your product's network software as described in your product documentation.
• Print a network status sheet and verify that the network settings are correct. If the network status is

Disconnected, check any cable connections and turn your product off and then on again.
• If you are using TCP/IP, make sure the product's IP address is set correctly for your network. If your

network does not assign IP addresses using DHCP, set the IP address manually.
• Make sure your computer and product are both using the same wireless network.
• If network printing is slow, print a network status sheet and check the signal strength. If it is poor, place

your product closer to your router or access point.

Note: Avoid placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal
object, such as a filing cabinet.

• If you are connecting the product via Wi-Fi Protected Setup (WPS) and the WiFi light on your product
is not solid green, make sure you press the Wi-Fi button on the product within 2 minutes of pressing
the WPS button on your router. Hold down the Wi-Fi button on the product for 3 seconds.

• If you are connecting the product via EpsonNet Setup and the WiFi light on your product is not solid
green, make sure your product software was installed correctly. If necessary, reinstall your software.

Parent topic: Solving Network Problems
Related tasks
Printing a Network Status Sheet

Printing a Network Status Sheet
You can print a network status sheet to help you determine the causes of any problems you may have
using your product on a network.
To print the status sheet, press the network status button on the product. Examine the settings shown
on the network status sheet to diagnose any problems you have.
Parent topic: Solving Network Problems

Solving Paper Problems
Check these sections if you have problems using paper with your product.
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Paper Feeding Problems
Paper Jam Problems
Paper Ejection Problems
Parent topic: Solving Problems

Paper Feeding Problems
If you have problems feeding paper, try these solutions:
• If paper does not feed for printing, remove it. Then reload it in the sheet feeder against the right side

and beneath the tab. Slide the edge guide against the edge of the paper, making sure that the paper
stack is not above the arrow mark on the edge guide.

• If multiple pages feed at once, remove the paper, fan the edges to separate the sheets, and reload it.
• If paper jams when you load only one or two sheets, try loading more sheets at a time. Do not load

more than the recommended number of sheets.
• If paper jams when you print on both sides of the paper, try loading fewer sheets.
• For best results, follow these guidelines:

• Use new, smooth, high-quality paper that is not curled, creased, old, too thin, or too thick.
• Load paper in the sheet feeder printable side up.
• Do not load paper with holes punched in it.
• Follow any special loading instructions that came with the paper.

Parent topic: Solving Paper Problems
Related references
Paper Jam Problems
Paper Loading Capacity
Related topics
Loading Paper

Paper Jam Problems
If you have problems with paper jams, follow these steps:
1. Cancel the print job from your computer, if necessary.
2. Gently pull out any jammed paper from the sheet feeder.
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3. Press the paper/cancel button to resume printing. If the product lights still show an error, continue
with the next step.

4. Press the power button to turn the product off.
5. Open the printer cover.
6. Remove any jammed paper, including torn pieces.
7. Close the printer cover and press the power button to turn the product back on.
8. Carefully follow all paper loading instructions when you load new paper.
Parent topic: Solving Paper Problems

Paper Ejection Problems
If you have problems with paper ejecting properly, try these solutions:
• If paper does not eject fully, you may have set the wrong paper size. Cancel printing to eject the paper.

Select the correct paper size when you reprint.
• If paper is wrinkled when it ejects, it may be damp or too thin. Load new paper and be sure to select

the correct paper type setting when you reprint.
Parent topic: Solving Paper Problems
Related references
Paper Jam Problems
Paper or Media Type Settings
Related tasks
Cancelling Printing Using a Product Button
Related topics
Loading Paper

Solving Problems Printing from a Computer
Check these sections if you have problems while printing from your computer.
Nothing Prints
Noise Occurs, But Nothing Prints
Noise When Product Sits for a While
Product Icon Does Not Appear in Windows Taskbar
Error After Cartridge Replacement
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Printing is Slow
Parent topic: Solving Problems

Nothing Prints
If you have sent a print job and nothing prints, try these solutions:
• Make sure your product is turned on.
• Make sure any interface cables are connected securely at both ends.
• If you connected your product to a USB hub, make sure it is a first-tier hub. If it still does not print,

connect your product directly to your computer instead of the hub.
• Run a product check to see if a test page prints. If the test page prints, check to see if your product

software is installed correctly.
• In Windows, make sure your product is selected as the default printer.
• In Windows, clear any stalled print jobs from the Windows Spooler:

• Windows 7: Click and select Devices and Printers. Right-click your product name, select See
what's printing, select your product name again if necessary, right-click the stalled print job, click
Cancel, and click Yes.

• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,
right-click your product name, select Open, right click the stalled print job, click Cancel, and click
Yes.

• Windows XP: Click Start and select Printers and Faxes. (Or open the Control Panel, select
Printers and Other Hardware if necessary, and select Printers and Faxes.) Right-click your
product name, select Open, right-click the stalled print job, click Cancel, and click Yes.

Parent topic: Solving Problems Printing from a Computer

Noise Occurs, But Nothing Prints
If your product makes a printing noise, but nothing prints, try these solutions:
• Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if

necessary.
• Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that

extends beyond the base of the product in all directions.
Parent topic: Solving Problems Printing from a Computer
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Noise When Product Sits for a While
Your product is performing routine maintenance. This is normal.
Parent topic: Solving Problems Printing from a Computer

Product Icon Does Not Appear in Windows Taskbar
If you do not see your product icon in the Windows taskbar, first try restarting your computer. If that does
not work, try this solution:
1. Do one of the following:

• Windows 7: Click and select Devices and Printers.

• Windows Vista: Click , select Control Panel, and click Printer under Hardware and Sound.
• Windows XP: Click Start and select Printers and Faxes. (Or open the Control Panel, select

Printers and Other Hardware if necessary, and Printers and Faxes.)
2. Right-click your product name, select Printing Preferences, and select your product name again if

necessary.
3. Click the Maintenance tab.
4. Click the Speed & Progress or Extended Settings button.
5. Click the Monitoring Preferences button.
6. Click the Shortcut Icon box.
7. Click OK to close the open program windows.
Parent topic: Solving Problems Printing from a Computer

Error After Cartridge Replacement
If you see an error light or error message after you replace an ink cartridge, follow these steps:
1. Remove and reinsert the ink cartridge you replaced, making sure to push it all the way into its slot.
2. Complete the ink cartridge installation steps.
Parent topic: Solving Problems Printing from a Computer
Related topics
Replacing Ink Cartridges
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Printing is Slow
If printing becomes slow, try these solutions:
• Make sure your system meets the requirements for your operating system. If you are printing a high-

resolution image, you may need more than the minimum requirements. If necessary, increase your
system's memory.

• If you are using Windows 7, close the Devices and Printers window before you print.
• Clear space on your hard drive or run a defragmentation utility to free up existing space.
• Close any programs you are not using when you print.
• If your product is connected to a USB hub, connect it directly to your computer instead.
• If printing becomes slower after printing continuously for a long time, the product may have

automatically slowed down to protect the print mechanism from overheating or becoming damaged.
Let the product rest with the power on for 30 minutes, then try printing again.

For the fastest printing, select the following settings in your product software:
• Make sure the paper type setting matches the type of paper you loaded.
• Turn on any high speed settings in your product software.
• Select a lower print quality setting.
• Windows: Click the Maintenance tab, select Speed & Progress or Extended Settings, and select

the following settings:
• High Speed Copies
• Always spool RAW datatype
• Page Rendering Mode
• Print as Bitmap

Parent topic: Solving Problems Printing from a Computer
Related references
Windows System Requirements
Mac System Requirements
Paper or Media Type Settings
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac OS X 10.5/10.6/10.7
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Selecting Basic Print Settings - Mac OS X 10.4

Solving Page Layout and Content Problems
Check these sections if you have problems with the layout or content of your printed pages.
Inverted Image
Too Many Copies Print
Blank Pages Print
Incorrect Margins on Printout
Incorrect Characters Print
Incorrect Image Size or Position
Slanted Printout
Parent topic: Solving Problems

Inverted Image
If your printed image is inverted unexpectedly, try these solutions:
• Turn off any mirror or inversion settings in your printing application.
• Turn off the Mirror Image, Flip horizontally, or Reverse page orientation settings in your printer

software. (This option has different names, depending on your operating system version.)

Note: Leave these options turned on when you print on EPSON Iron-on Cool Peel Transfer paper, if
available for your product.

Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Print Layout Options - Windows
Selecting Basic Print Settings - Mac OS X 10.5/10.6/10.7
Selecting Basic Print Settings - Mac OS X 10.4

Too Many Copies Print
Make sure that the Copies setting in your printing program or printer software is not set for multiple
copies.
Parent topic: Solving Page Layout and Content Problems
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Blank Pages Print
If blank pages print unexpectedly, try these solutions:
• Make sure you selected the correct paper size settings in your printing program and printer software.
• If a blank page exists in a document you are printing and you want to skip printing it, select the Skip

Blank Page setting in your printer software.
• Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if

necessary.
• Make sure your product is selected as the printer in your printing program.
Parent topic: Solving Page Layout and Content Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac OS X 10.5/10.6/10.7
Selecting Page Setup Settings - Mac OS X 10.4
Selecting Printing Preferences - Mac OS X 10.5/10.6/10.7
Selecting Printing Preferences - Mac OS X 10.4

Incorrect Margins on Printout
If your printed page has incorrect margins, try these solutions:
• Make sure you selected the correct paper size settings in your printing program and printer software.
• Make sure you selected the correct margins for your paper size in your printing program.
• Make sure your paper is positioned correctly for feeding into the printer.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac OS X 10.5/10.6/10.7
Selecting Page Setup Settings - Mac OS X 10.4
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Related topics
Loading Paper

Incorrect Characters Print
If incorrect characters appear in your prints, try these solutions before reprinting:
• Make sure any cables are securely connected at both ends.
• In Windows, delete all print jobs from the Windows Spooler:

• Windows 7: Click and select Devices and Printers. Right-click your product name, select See
what's printing, select your product name again if necessary, right-click the stalled print job, click
Cancel, and click Yes.

• Windows Vista: Click and select Control Panel. Click Printer under Hardware and Sound,
right-click your product name, select Open, right click the stalled print job, click Cancel, and click
Yes.

• Windows XP: Click Start and select Printers and Faxes. (Or open the Control Panel, select
Printers and Other Hardware if necessary, and select Printers and Faxes.) Right-click your
product name, select Open, right-click the stalled print job, click Cancel, and click Yes.

• Make sure your product is selected as the printer in your printing program.
• If your product is connected to a USB hub, connect it directly to your computer instead.
Parent topic: Solving Page Layout and Content Problems

Incorrect Image Size or Position
If your printed image is the wrong size or in the wrong position, try these solutions:
• Make sure you selected the correct paper size and layout settings in your printing program and printer

software.
• Make sure your paper is positioned correctly for feeding into the printer.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac OS X 10.5/10.6/10.7
Selecting Page Setup Settings - Mac OS X 10.4
Selecting Print Layout Options - Windows
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Selecting Print Layout Options - Mac OS X 10.5/10.6/10.7
Selecting Print Layout Options - Mac OS X 10.4
Related topics
Loading Paper

Slanted Printout
If your printouts are slanted, try these solutions:
• Slide the edge guide against the edge of the paper.
• Select a higher print quality setting in your printer software.
• Align the print head.
• Make sure the product is not printing while tilted or at an angle.
Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Basic Print Settings - Mac OS X 10.5/10.6/10.7
Selecting Advanced Print Settings - Windows
Selecting Basic Print Settings - Mac OS X 10.5/10.6/10.7
Selecting Basic Print Settings - Mac OS X 10.4
Related topics
Loading Paper

Solving Print Quality Problems
Check these sections if your printouts have problems with print quality, but your image looks fine on your
computer screen.
White or Dark Lines in Printout
Blurry or Smeared Printout
Faint Printout or Printout Has Gaps
Grainy Printout
Incorrect Colors
Parent topic: Solving Problems
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White or Dark Lines in Printout
If you notice white or dark lines in your prints (also called banding), try these solutions before you reprint:
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• Make sure the paper type setting matches the type of paper you loaded.
• Make sure you loaded the printable side of the paper faceup.
• Turn off any high speed settings in your product software.
• Align the print head.
• You may need to replace the ink cartridges.
Parent topic: Solving Print Quality Problems
Related concepts
Print Head Cleaning
Print Head Alignment
Related references
Paper or Media Type Settings
Related tasks
Selecting Advanced Print Settings - Windows
Selecting Printing Preferences - Mac OS X 10.5/10.6/10.7
Selecting Printing Preferences - Mac OS X 10.4
Related topics
Replacing Ink Cartridges

Blurry or Smeared Printout
If your printouts are blurry or smeared, try these solutions:
• Make sure your paper is not damp, curled, old, or loaded facedown in the sheet feeder (the printable

side should be faceup).
• Use a support sheet with special paper, or load special paper one sheet at a time.
• Make sure your paper meets the specifications for your product.
• Use EPSON papers to ensure proper saturation and absorption of genuine EPSON inks.
• Make sure the paper type setting in your product software matches the type of paper you loaded.
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• Remove each sheet from the output tray as it is printed.
• Avoid handling printouts on glossy paper right after printing to allow the ink to set.
• Turn off any high speed settings in your product software.
• If you print on both sides of a sheet of paper, smudges may appear on the reverse side of heavily

saturated or dark images. If one side of a sheet will contain a lighter image or text, print that side first.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• Align the print head.
• Clean the paper path.

Note: Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that
extends beyond the base of the product in all directions.

Parent topic: Solving Print Quality Problems
Related concepts
Print Head Cleaning
Print Head Alignment
Related references
Available EPSON Papers
Paper Specifications
Related tasks
Selecting Basic Print Settings - Windows
Selecting Advanced Print Settings - Windows
Selecting Basic Print Settings - Mac OS X 10.5/10.6/10.7
Selecting Basic Print Settings - Mac OS X 10.4
Selecting Printing Preferences - Mac OS X 10.5/10.6/10.7
Selecting Printing Preferences - Mac OS X 10.4
Cleaning the Paper Path
Related topics
Loading Paper
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Faint Printout or Printout Has Gaps
If your printouts are faint or have gaps, try these solutions:
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• The ink cartridges may be old or low on ink, and you may need to replace them.
• Make sure the paper type setting matches the type of paper you loaded.
• Make sure your paper is not damp, curled, old, or loaded facedown in the sheet feeder (the printable

side should be faceup).
• Align the print head.
• Clean the paper path.
Parent topic: Solving Print Quality Problems
Related concepts
Print Head Cleaning
Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac OS X 10.5/10.6/10.7
Selecting Basic Print Settings - Mac OS X 10.4
Cleaning the Paper Path
Related topics
Replacing Ink Cartridges
Loading Paper

Grainy Printout
If your printouts are grainy, try these solutions:
• Make sure you loaded the printable side of the paper faceup in the sheet feeder.
• Select a higher print quality setting and turn off any high speed settings in your product software.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• Align the print head.
• You may need to increase the image resolution or print a smaller size; see your software

documentation.
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Parent topic: Solving Print Quality Problems
Related concepts
Print Head Alignment
Related tasks
Selecting Advanced Print Settings - Windows
Selecting Basic Print Settings - Mac OS X 10.5/10.6/10.7
Selecting Basic Print Settings - Mac OS X 10.4
Selecting Printing Preferences - Mac OS X 10.5/10.6/10.7
Selecting Printing Preferences - Mac OS X 10.4
Related topics
Loading Paper

Incorrect Colors
If your printouts have incorrect colors, try these solutions:
• Make sure the Black/Grayscale or Grayscale setting is not selected in your printer software.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if

necessary.
• The ink cartridges may be old or low on ink, and you may need to replace them.
• Your printed colors can never exactly match your on-screen colors. However, you can use a color

management system to get as close as possible. Try using the color management options in your
printer software.

• For best results, use genuine EPSON ink and paper.
Parent topic: Solving Print Quality Problems
Related concepts
Print Head Cleaning
Related references
Available EPSON Papers
Related tasks
Selecting Advanced Print Settings - Windows
Managing Color - Mac OS X 10.5/10.6/10.7
Managing Color - Mac OS X 10.4
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Related topics
Replacing Ink Cartridges

When to Uninstall Your Product Software
If you have a problem that requires you to uninstall and re-install your software, follow the instructions for
your operating system.
Uninstalling Printing Software - Windows
Uninstalling Product Software - Mac OS X
Parent topic: Solving Problems

Uninstalling Printing Software - Windows
You can uninstall and then re-install your printer software to solve certain problems.
1. Turn off the product.
2. Disconnect any interface cables.

3. Click or Start, and select All Programs or Programs.
4. Select EPSON, select your product, then click EPSON Printer Software Uninstall.

Note: If you see a User Account Control window, click Yes or Continue.

5. In the next window, select your product and click OK. Then follow any on-screen instructions to
uninstall your printer software and utilities.

6. Restart your computer, then see the Start Here sheet to re-install your software.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

Parent topic: When to Uninstall Your Product Software

Uninstalling Product Software - Mac OS X
In most cases, you do not need to uninstall your product software before re-installing it. However, you
can download the Uninstall Center utility from the Epson support website to uninstall your product
software as described here.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.
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1. To download the Uninstall Center utility, visit the Epson download site (U.S. downloads or Canadian
downloads).

2. Follow the instructions on the screen to install the Uninstall Center.
3. Quit all applications currently running on your Mac.
4. Select the checkbox for each software program you want to uninstall.
5. Click Uninstall.
6. Follow the on-screen instructions to uninstall the software.
7. To reinstall your product software, see the Start Here sheet for instructions.

Note: If you uninstall the printer driver and your product name remains in the Print & Fax or Print & Scan
window, select your product name and click the – (remove) icon to remove it.

Parent topic: When to Uninstall Your Product Software

Where to Get Help
If you need to contact Epson for technical support services, use the following support options.

Internet Support
Visit Epson's support website at www.epson.com/support (U.S.) or www.epson.ca/support (Canada) for
solutions to common problems. You can download drivers and documentation, get FAQs and
troubleshooting advice, or e-mail Epson with your questions.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:
• Product name
• Product serial number (located on a label on the product)
• Proof of purchase (such as a store receipt) and date of purchase
• Computer configuration
• Description of the problem
Then call:
• U.S.: (562) 276-7282, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM, Pacific

Time, Saturday
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• Canada: (905) 709-2567, 6 AM to 8 PM, Pacific Time, Monday through Friday
Days and hours of support are subject to change without notice. Toll or long distance charges may
apply.

Purchase Supplies and Accessories
You can purchase genuine EPSON ink and paper at EPSON Supplies Central at www.epson.com/ink3
(U.S. sales) or www.epson.ca (Canadian sales). You can also purchase supplies from an EPSON
authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).
Parent topic: Solving Problems
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Technical Specifications
These sections list the technical specifications for your product.

Note: Epson offers a recycling program for end of life products. Please go to www.epson.com/recycle for
information on how to return your products for proper disposal.

Windows System Requirements
Mac System Requirements
Printing Specifications
Paper Specifications
Printable Area Specifications
Ink Cartridge Specifications
Dimension Specifications
Electrical Specifications
Environmental Specifications
Interface Specifications
Network Interface Specifications
Safety and Approvals Specifications

Windows System Requirements
To use your product and its software, your computer should use one of these operating systems:
• Microsoft Windows 7
• Windows Vista
• Windows XP Professional x64 Edition
• Windows XP SP1 or higher

Note: Visit Epson's support website at www.epson.com/support (U.S.) or www.epson.ca/support
(Canada) for the latest in compatibility and drivers for your product.

Parent topic: Technical Specifications
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Mac System Requirements
To use your product and its software, your Mac should use one of these operating systems:
• Mac OS X 10.4.11
• Mac OS X 10.5.8
• Mac OS X 10.6.x
• Mac OS X 10.7.x

Note: Visit Epson's support website at www.epson.com/support (U.S.) or www.epson.ca/support
(Canada) for the latest in compatibility and drivers for your product.

Parent topic: Technical Specifications

Printing Specifications
Paper path Sheet feeder, top entry
Sheet feeder capacity Approximately 100 sheets at 20 lb (75 g/m2)

Parent topic: Technical Specifications

Paper Specifications
Use paper under normal conditions:
• Temperature: 59 to 77 ºF (15 to 25 ºC)
• Humidity: 40 to 60% RH

Note: Since the quality of any particular brand or type of paper may be changed by the manufacturer at
any time, Epson cannot guarantee the quality of any non-Epson brand or type of paper. Always test a
sample of paper stock before purchasing large quantities or printing large jobs.

135

http://www.epson.com/support
http://www.epson.ca/support


Single-sheets

Size A4 (8.3 × 11.7 inches [210 × 297 mm])
A6 (4.1 × 5.8 inches [105 × 148 mm])
Letter (8.5 × 11 inches [216 × 279 mm])
Legal (8.5 × 14 inches [216 × 357 mm])
4 × 6 inches (102 × 152 mm)
5 × 7 inches (127 × 178 mm)
8 × 10 inches (203 × 254 mm)
3.5 × 5 inches (89 × 127 mm)
16:9 wide (4 × 7.1 inches [102 × 434 mm])
Half Letter (5.5 × 8.5 inches [140 × 279 mm])
11 × 14 inches (279 × 356 mm)
11 × 17 inches (279 × 432 mm)
11.7 × 16.5 inches (297 × 420 mm)
12 × 12 inches (305 × 305 mm)
13 × 19 inches (330 × 483 mm)

Paper types Plain paper and paper distributed by Epson
Thickness 0.003 to 0.004 inch (0.08 to 0.11 mm)
Weight 17 lb (64 g/m2) to 24 lb (90 g/m2)

Envelopes

Size No. 10 (4.1 × 9.5 inches [105 × 241 mm])
Paper types Plain bond paper
Weight 20 lb (75 g/m2) to 24 lb (90 g/m2)

Parent topic: Technical Specifications
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Printable Area Specifications
Note: When printing borderless, quality may decline in the expanded printable area.

Single sheets

1 Top: 0.12 inch (3.0 mm) minimum
2 Left: 0.12 inch (3.0 mm) minimum
3 Right: 0.12 inch (3.0 mm) minimum
4 Bottom: 0.12 inch (3.0 mm) minimum
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Envelopes

1 Left: 0.12 inch (3.0 mm) minimum
2 Bottom: 0.20 inch (5.0 mm) minimum
3 Top: 0.20 inch (5.0 mm) minimum
4 Right: 0.78 inch (20 mm) minimum

CD/DVDs
12-cm CD/DVDs
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1 0.8 inch (21 mm) minimum inner margin
2 4.7 inches (120 mm) maximum outer margin

8-cm CD/DVDs

1 0.8 inch (21 mm) minimum inner margin
2 3.2 inches (80 mm) maximum outer margin

Note: Avoid printing in the clear plastic areas of discs to prevent staining the disc with ink.
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Parent topic: Technical Specifications

Ink Cartridge Specifications
Note: We recommend that you use genuine EPSON cartridges and do not refill them. The use of other
products may affect your print quality and could result in printer damage.
The printer ships with full cartridges and part of the ink from this first set of cartridges is used for priming
the printer. Yields vary considerably based on images printed, print settings, paper type, frequency of
use, and temperature. For print quality, a variable amount of ink remains in the cartridge after the
"replace cartridge" indicator comes on.

Color Black, Cyan, Magenta, Yellow, Light Cyan, Light Magenta
Cartridge life Opened package: 6 months

Unopened package: do not use if the date on the package has
expired

Temperature Storage: –4 to 104 ºF (–20 to 40 ºC)
1 month at 104 ºF (40 ºC)
Ink freezes at 3.2 ºF (–16 ºC)
Ink thaws and is usable after 3 hours at 77 ºF (25 ºC)

Note: For best printing results, use up a cartridge within 6 months of opening the package.

Parent topic: Technical Specifications

Dimension Specifications
Height Stored: 8.5 inches (215 mm)

Printing: 16.3 inches (415 mm)
Width Stored: 24.3 inches (616 mm)

Printing: 24.3 inches (616 mm)
Depth Stored: 12.7 inches (322 mm)

Printing: 31.4 inches (798 mm)
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Weight 26.0 lb (11.8 kg)
(without ink cartridges, power
cable, and the CD/DVD tray)

Parent topic: Technical Specifications

Electrical Specifications
Power supply rating 100 to 120 V
Input voltage range 100 to 120 V model: 90 to 132 V
Rated frequency range 50/60 Hz
Input frequency range 49.5/60.5 Hz
Rated current 100 to 120 V model: 0.6 A
Power consumption Printing: Approx. 18.0 W (ISO/IEC24712)
(100 to 120 V model) Ready mode: Approx. 7.0 W

Sleep mode: Approx. 3.3 W
Power off mode: Approx. 0.2 W

Parent topic: Technical Specifications

Environmental Specifications
Temperature Operating: 50 to 95 ºF (10 to 35 ºC)

Storage: –4 to 104 ºF (–20 to 40 ºC)
1 month at 104 ºF (40 ºC)

Humidity Operating: 20 to 80% RH
(non-condensing) Storage: 5 to 85% RH

Parent topic: Technical Specifications
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Interface Specifications
Interface type Hi-Speed USB (Device class for computers)

Hi-Speed USB (for PictBridge-compliant devices)

Note: Epson cannot guarantee the operation of externally connected devices.

Parent topic: Technical Specifications

Network Interface Specifications
Wireless LAN standard IEEE 802.11 b/g/n
Wireless security WPA-PSK (TKIP/AES) WPA2 compliant

WEP (64/128 bit)
Frequency band 2.4 GHz
Communication mode Infrastructure mode

Ad hoc mode

Note: Wireless LAN standard complies with either IEEE 802.11 b/g or IEEE 802.11 b/g/n, depending on
purchase location.

Parent topic: Technical Specifications

Safety and Approvals Specifications
United States Safety: UL60950-1

EMC: FCC part 15 Subpart B class B
Canada Safety: CAN/CSA C22.2 No. 60950-1

EMC: CAN/CSA-CEI/IEC CISPR 22 Class B

This equipment contains the following wireless module:
• Manufacturer: Marvell Semiconductor Inc.
• Type: SP88W8786-MD0-2C2T00
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This product conforms to Part 15 of FCC Rules and RSS-210 of the IC Rules. Epson cannot accept
responsibility for any failure to satisfy the protection requirements resulting from a non-recommended
modification of the product. Operation is subject to the following two conditions: (1) this device may not
cause harmful interference, and (2) this device must accept any interference received, including
interference that may cause undesired operation of the device.
To prevent radio interference to the licensed service, this device is intended to be operated indoors and
away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed
outdoors is subject to licensing.
Parent topic: Technical Specifications
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Notices
Check these sections for important notices about your product.

Note: Epson offers a recycling program for end of life products. Please go to www.epson.com/recycle for
information on how to return your products for proper disposal.

FCC Compliance Statement
Software Notices
Trademarks
Copyright Notice

FCC Compliance Statement
For United States Users
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio or television reception. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause interference to radio and television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

WARNING
The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC
Certification or Declaration of this device and may cause interference levels which exceed the limits
established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded
equipment interface cable with this device. If this equipment has more than one interface connector, do
not leave cables connected to unused interfaces. Changes or modifications not expressly approved by
the manufacturer could void the user’s authority to operate the equipment.
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For Canadian Users
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment
Regulations.
Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le materiel
brouilleur du Canada.
Parent topic: Notices

Software Notices
OPEN SOURCE SOFTWARE LICENSE
1. This printer product includes open source software programs listed in Section 6) according to the

license terms of each open source software program.
2. We provide the source code of the GPL Programs, LGPL Programs and Apple Public Source License

Programs (each is defined in Section 6) until five (5) years after the discontinuation of same model of
this printer product. If you desire to receive the source code above, please contact Epson customer
support for your region. You shall comply with the license terms of each open source software
program.

3. The open source software programs are WITHOUT ANY WARRANTY; without even the implied
warranty of MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. See the license
agreements of each open source software program for more details, which are described in OSS.pdf
on your Printer Software CD.

4. OpenSSL toolkit
This printer product includes software developed by the OpenSSL project for use in the OpenSSL
Toolkit (http://www.openssl.org/).
This product includes cryptographic software written by Eric Young (eay@cryptsoft.com).

5. The license terms of each open source software program are described in OSS.pdf on your Printer
Software CD.

6. The list of open source software programs which this printer product includes are as follows.
GNU GPL
This printer product includes the open source software programs which apply the GNU General Public
License Version 2 or later version ("GPL Programs").
The list of GPL Programs:
busybox_1.7.2
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coreutils_5.2.1
debianutils_2.6.2
dpkg_1.10.18
hostname_2.10
ifupdown_0.6.4
inetutils-ftpd_1.4.2
initscripts_2.85
libc6_2.3.6
libgcc1_4.1.1
login_4.0.3
module-init-tools-1.60.9
net-tools_1.60
netbase_4.14
procps_3.1.14
sysvinit-2.85
telnetd_0.17.21
udhcp 0.9.8cvs20050124-5
util-linux-2.12
usb8786
GNU LGPL
This printer product includes the open source software programs which apply the GNU Lesser General
Public License Version 2 or later version ("LGPL Programs").
The list of LGPL Programs:
inetutils-ftpd_1.4.2
libc6_2.3.6
procps_3.1.14
sysvinit-2.85
zeroconf 0.6.1-1
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iksemel 1.4
Apple Public Source License
This printer product includes the open source software programs which apply the Apple Public Source
License Version 1.2 or its latest version ("Apple Public Source License Programs").
Apple Public Source License Programs:
Bonjour
Net-SNMP license
This printer product includes the open source software program "Net-SNMP" which applies the terms
and conditions provided by owner of the copyright to the "Net-SNMP".
OpenSSL License/Original SSLeay License
This printer product includes t he open source software program "OpenSSL toolkit" which applies the
license terms of OpenSSL License and Original SSLeay License.
BSD License (Berkeley Software Distribution License)
This printer product includes the open source software programs which apply the Berkeley Software
Distribution License ("BSD Programs").
The list of BSD Programs:
busybox_1.7.2
coreutils_5.2.1
ftp_0.17
libc6_2.3.6
inetutils-ftpd_1.4.2
linux-ftpd-0.17
module-init-tools-1.60.9
netkit-inetd_0.10
netkit-ping_0.10
portmap_5-2.1
util-linux-2.12
Sun RPC License
This printer product includes the open source software programs which apply the Sun RPC License
("Sun RPC Programs").
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The list of Sun RPC Programs:
libc6_2.3.6
netkit-inetd_0.10
netkit-ping_0.10
portmap_5-2.1
glibc license
This printer product includes the open source software program "glibc" which applies the terms and
conditions provided by owner of the copyright to the "glibc".
The list of "glibc" Programs:
libc6_2.3.6
TCP Wrappers license
This printer product includes the open source software program "TCP Wrappers" which applies the
terms and conditions provided by owner of the copyright to the "TCP Wrappers".
"TCP Wrappers" Program:
libwrap0_7.6
libncurses license
This printer product includes the open source software program "libncurses" which applies the terms and
conditions provided by owner of the copyright to the "libncurses".
"libncurses" Program:
libncurses5_5
busybox license
This printer product includes the open source software program "busybox" which applies the terms and
conditions provided by owner of the copyright to the "busybox".
"busybox" Program:
busybox_1.7.2
debianutils license
This printer product includes the open source software program "debianutils" which applies the terms
and conditions provided by owner of the copyright to the "debianutils".
"debianutils" Program:
debianutils_2.6.2
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shadow license
This printer product includes the open source software program "shadow" which applies the terms and
conditions provided by owner of the copyright to the "shadow".
"shadow " Program:
login_4.0.3
telnetd license
This printer product includes the open source software program "telnetd" which applies the terms and
conditions provided by owner of the copyright to the "telnetd".
"telnetd" Program:
telnetd_0.17.21
telnetd license
This printer product includes the open source software program "telnetd" which applies the terms and
conditions provided by owner of the copyright to the "telnetd".
"telnetd" Program:
telnetd_0.17.21
ARC4 license
This printer product includes the open source software program "ARC4" which applies the terms and
conditions provided by owner of the copyright to the "ARC4".
"ARC4" Program:
ARC4
SHA1 license
This printer product includes the open source software program "SHA1" which applies the terms and
conditions provided by owner of the copyright to the "AES".
"SHA1" Program:
SHA1
Parent topic: Notices

Trademarks
EPSON®, Artisan®, and EPSON Supplies Central® are registered trademarks, and EPSON Exceed Your
Vision is a registered logomark of Seiko Epson Corporation.
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EPSON StoreSM is a service mark of Epson America, Inc.
General Notice: Other product names used herein are for identification purposes only and may be
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

Parent topic: Notices

Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise,
without the prior written permission of Seiko Epson Corporation. The information contained herein is
designed only for use with this EPSON product. Epson is not responsible for any use of this information
as applied to other products.
Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of:
accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this
product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.
Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any
options or any consumable products other than those designated as Original EPSON Products or
EPSON Approved Products by Seiko Epson Corporation.
Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic
interference that occurs from the use of any interface cables other than those designated as EPSON
approved Products by Seiko Epson Corporation.
This information is subject to change without notice.
A Note Concerning Responsible Use of Copyrighted Materials
Default Delay Times for Power Management for EPSON Products
Copyright Attribution
Parent topic: Notices
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A Note Concerning Responsible Use of Copyrighted Materials
Epson encourages each user to be responsible and respectful of the copyright laws when using any
EPSON product. While some countries' laws permit limited copying or reuse of copyrighted material in
certain circumstances, those circumstances may not be as broad as some people assume. Contact your
legal advisor for any questions regarding copyright law.
Parent topic: Copyright Notice

Default Delay Times for Power Management for EPSON Products
This product will enter sleep mode after a period of nonuse. The time interval has been set at the factory
to ensure that the product meets Energy Star standards of energy efficiency, and cannot be modified by
the consumer.
Parent topic: Copyright Notice

Copyright Attribution
© 2011 Epson America, Inc.
11/11
CPD-35560
Parent topic: Copyright Notice
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